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INTRODUCTION

This quick start is addressed to users of the NVIDIA® Control Panel software. This guide
focuses on getting you up and running with your NVIDIA software.

For technical details on the features and benefits of the NVIDIA Control Panel software
and details about supported products, drivers, and other software, refer to the NVIDIA
web page — www.nvidia.com.

This chapter discusses the following major topics:
» “About the NVIDIA Control Panel” on page 2
P “Getting Support and Information” on page 5
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Chapter 01 : Introduction

About the NVIDIA Control Panel

Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows® XP,
Windows Vista, and Windows 7. You can use NVIDIA Control Panel to control your
NVIDIA hardware and access other NVIDIA software installed on your system.

Overview

In addition to setting up basic display configurations such as display resolution, refresh
rate, and multiple display use, you can:

» Tune your 3D settings with real-time preview to maximize performance or image
quality

» Customize how 3D applications work in your system

» Adjust your screen colors and contrast

» Set custom timings

» Control video image settings

» Change your HDTV format

» Control your notebook system power using PowerMizer

» Control special workstation features such as Frame Synchronization.

Feature Differences from the Classic Control Panel

The following are features that were available in the NVIDIA classic control panel, but
which are not available in the new NVIDIA Control Panel:

» Creating/Importing Color Profiles
» High Resolution Scalable Desktop
» Video Zoom

» Full-screen video mirroring

» Edge Blending

» nView Desktop Manager

nView Desktop Manager is available through the Windows control panel as a separate
applet (Windows XP only).

» MultiView Display Mode (for NVIDIA Quadro NVS graphics cards)

As of driver Release 173, MultiView is available from the Windows Display
Properties->Settings->Advanced tab for Windows XP only.
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Changes in Release 195/196/197

Workstation Pages

» Manage Quadro Plex Settings - now available under Windows Vista and Windows
7.

PhysX Indicator

Enabled through the 3D Settings menu bar item, the PhysX indicator appears when
running applications to let you verify the type of PhysX acceleration the game is using -
CPU or GPU - or whether PhysX acceleration is being used at all. This feature also
appears in later Release 190 drivers.

Supported Operating Systems

NVIDIA Release 195/196/197 Graphics drivers are available for the following Microsoft®
Windows® operating systems:

* Windows XP Media Center Edition 2005 Update Rollup 2
e Windows XP Media Center Edition 2005/2004
¢ Windows XP Professional

¢ Windows XP Home Edition

e Windows XP Professional x64 Edition

¢ Windows Server 2003 x64 Edition

¢ Windows Vista Home Basic

e Windows Vista Home Premium

¢ Windows Vista Business

* Windows Vista Enterprise Edition

¢ Windows Vista Ultimate

e Windows 7 32-bit and 64-bit Editions

Supported NVIDIA Products

Refer to the release notes and NVIDIA driver download site for the list of products
supported by the driver version that you have installed on your computer.
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Supported Languages

The NVIDIA Graphics Driver supports the following languages in the NVIDIA Control
Panel:

English (USA) German Portuguese (Euro/Iberian)
English (UK) Greek Russian

Arabic Hebrew Slovak

Chinese (Simplified) Hungarian Slovenian

Chinese (Traditional) Italian Spanish

Czech Japanese Spanish (Latin America)
Danish Korean Swedish

Dutch Norwegian Thai

Finnish Polish Turkish

French Portuguese (Brazil)

Other NVIDIA Software Applications

If installed, other NVIDIA software that you can access from the NVIDIA Control Panel
includes:

» NVIDIA System Tools-Performance group and System Update
» NVIDIA Stereoscopic 3D

» NVIDIA MediaShield™

» NVIDIA Network Access Manager

See the respective user documentation for information about these applications and
instructions on how to use them.
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Getting Support and Information

Online Help

» To open the online help, either :
e Press F1 on your keyboard, or

e Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA
Control Panel Help.

» Help on various topics can be viewed using the Contents, Index, or Search tabs.

Technical Support

To access the NVIDIA Technical Support web page go the following web address:

http://www.nvidia.com/page/support.html

System Information

You can get detailed information about your system and the NVIDIA Control Panel
configuration as well as version and copyright information.

» To view copyright and version information about the NVIDIA Control Panel:
From the Help menu, select About NVIDIA Control Panel.
» To view detailed system information:

Open the System Information dialog box by either selecting System Information from
the Help menu, or by clicking the System Information link at the lower left corner
of the NVIDIA Control Panel.

Click any of the tabs in the System Information dialog box.
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UNDERSTANDING THE NVIDIA
CONTROL PANEL

This chapter describes the NVIDIA Control Panel in the following sections:
» “Opening and Closing the New NVIDIA Control Panel” on page 7
» “About the NVIDIA Control Panel Interface” on page 8
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Opening and Closing the New NVIDIA Control Panel

» You can open the NVIDIA Control Panel in several ways:

¢ Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

For Windows XP

¢ From the Windows Start menu, select Control Panel, then in the Control Panel
window, double-click on the NVIDIA Control Panel icon.

%‘

MNYIDIA
Contral Panel

For Windows Vista/Windows 7

¢ From the Classic View of the Windows Control Panel, click the NVIDIA Control
Panel icon, or

%‘

MNYIDIA
Control Panel

e From the Control Panel Home view of the Windows Control Panel, click Additional
Options and then click NVIDIA Control Panel from the Additional Options

page.
» To close the NVIDIA Control Panel,

e From the File menu, select Exit, or

 C(lick the Close box in the upper right corner of the program window.
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About the NVIDIA Control Panel Interface

The NVIDIA Control Panel provides an easy-to-use interface for managing your system.

When you start the program for the first time, the NVIDIA Control Panel opens to the
first page listed in the navigation tree. On subsequent visits, the control panel reopens to
the last page visited. The NVIDIA Control Panel user interface consists of these main
areas, as shown in Figure 2.1 and Figure 2.2:

» Main Task Area

P Select a Task (Navigation tree)
» Menu bar

» Toolbar .

Tool Bar Menu Bar

& NvIDIA Control Panel
Eile Edit View Help

\;D ack \) Advanced Settings ~

Select a Task...

A Siirgg just Image Settings with Preview
Adjust image sektings with pre--‘we}-.t :
Manage 3D settings This page allows you o preview changes you make to the image and rendering settings. These will be your default settings for your
Monitor temperature levels hardware-accelerated 3D applications that ullize Direct3D or OpenGGL.
= Display
Maove CRT screen position
Change resolution Performance: Preview:

Adjust desktop color sebtings
Rotate display
Manage custom resolutions
Run multiple display wizard
Set up multiple: displays
= Video & Television
Adjust video color settings
Modify Full-screen video options
(= Workstation
View system topology
Synchronize displays
Adjust edge overlap

‘What do I look for?

gf-‘/‘;ilﬁﬂwagidﬂ:' () Let the 30 application decide

e s (OUse the advanced 30 image settings  Lake me there
but curved lines will O Use my preference emphasizing: Quality

appear jagged.

Moving towards the

Quality side will improve
the smoothress you
can see on curved lines.

Select a Task Pane Description:

D) System Information

Typical usage scenarios: |

|
Control Panel Main Task Area

Figure 2.1 NVIDIA Control Panel (Windows XP Example)
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Tool Bar Menu Bar

File Edit View Help

--e Back - @ | Advanced Settings +

Adjust Image Settings with Preview F

- 3D Settings
Adjust image settings with preview
Manage 30 settings _ _ .
i This page allows you to preview changes you make to the image and rendering settings. These will be your default settings for your
E-Display hardy 3D applications that wtilize Direct3D or OpenGL.
(Change resolution
Adjust desktop color settings

Rotate display Performance: Preview:
Set up multiple displays 1 p:

£1-Video & Television
Adiust video cokor settings

Quality:

/ What do I look for?
Moving towards the @ Let i ick
~ @ L pplica
Performance side wil e Do on decide

increase frame rate, () Use the advanced 3D image settings ~ Take me there

but curved nes will (©) Use my preference emphasizing: Quality
appear jagged.

Moving towards the
Quality side will improve
the smoothness you

can see on curved ines,

Performance Quality

Description:

) System Infogmation Typical usage scenarios:

Select a Task Pane Control Panel Main Task Area

Figure 2.2 NVIDIA Control Panel (Windows Vista Example)

Using the Main Task Area

The main task area, in the right pane, displays the application task pages. This area of the
screen is where you will focus most of your attention as you use the NVIDIA Control
Panel to accomplish your goals. You can access specific pages using the navigation tree in
the Select a Task pane.

NVIDIA Control Panel Quick Start Guide Release 195/196/197 v50 | 9



Chapter 02 : Understanding the NVIDIA Control Panel

Using the Select a Task Pane

The navigation tree in the Se/ect « Task pane shows all the primary NVIDIA Control pages
that are installed on your system.

The pages are grouped according to the same categories that existed in the previous
version of the NVIDIA Control Panel.

Select a Task. ..

i=]- 30 Settings

ndjusk image sektings with prewvigw
Manage 30 sekkings
Manitar kemperature levels

[=|- Display

Fun display aptirization wizard
Maove CRT screen position
Zhange resalutian

adjusk deskkop color sektings
Rotate display

Manage custom resalukions
Sek up mulkiple displays

[=)- Wideo & Telewvision

adjust viden calar setkings

Click to expand
or collapse the
group list.

=) WiaFRSESEon

Wigw svstem bopalagy
Synchronize displays
adjust edge overlap

Click to open the
corresponding page
in the main task area.

Figure 2.3 NVIDIA Control Panel Select a Task pane

NVIDIA Control Panel Quick Start Guide
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Chapter 02 : Understanding the NVIDIA Control Panel

Using the Tool Bar

The Toolbar provides quick back and forth navigation between pages, and also lets you
choose a view setting.

Using the Navigation Buttons

The back and forward buttons let you navigate sequentially among pages that you have
visited.

You can also navigate directly to a previously visited page by clicking the list arrow next
to the back button. The drop-down menu lists all the previously visited pages in the
queue. Click the page that you want.

NVIDIA Control Panel
File Edit wiew Profiles Display Help

Standard Settings ~

Change resolution
Morve CRT screen position
Adjust image settings with previem

Working with View Settings

The currently selected view determines what options on each page are available..

NYIDIA Control Panel

File Edit Wiew Profiles Display Help

eBack *e -

Select a Task... * Skandard
= 3D Settings Advanced
Adijust imange setkjn
Manitor temperakiyrs N

Define Cuskom View, ..

[=)- Display r.
Figure 2.5 NVIDIA Control Panel View Settings

There are three available views:
p Standard
» Advanced
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» Custom

Most commands are available for both Standard and Advanced views. However, some
options are available only if the Advanced view is selected before opening the page.
Also, task page options may different depending on the selected view. If the command
you're looking for is not displayed, select a different view.

To change the view:

» From the View menu, select Standard, Advanced, or Custom.

For the Custom command to be available, you must define a custom view as described
in the following section.

Defining Custom Views

You can customize NVIDIA Control Panel to display only the task pages you want to see
and use.
To specify which the pages to display:

1 Select View > Define Custom View... or for quicker access, use the toolbar if you
have it enabled.

2 On the Create Custom View page, select (check) the check boxes for the pages that
you want to view and click OK.

3 To leave the Custom View mode, select either Standard or Advanced from the View
menu or for quicker access, use the toolbar if you have it enabled.

4 To switch back to your custom view, select Custom.

Using the Menu Bar

The Menu bar contains standard Windows menus and menus specific to the NVIDIA
Control Panel, such as the View and Profiles menus.

Menus that are available on the menu bar may vary, depending on the NVIDIA Control
Panel group (such as, Display, Mobile, 3D Settings, or other group) you are using.
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File Menu

Commands related to printing, applying changes, and exiting the program are available
on the File menu.

Table 2.1  File Menu Commands

File Menu Description
Command
Page Setup ... Set up the current task page for printing. This control may not
be available.
Print... Print the current task page. This control may not be available.
Print Preview the page before sending it to the printer. This control
Preview.... may not be available.
Exit Close the NVIDIA Control Panel program.
Edit Menu

Commands related to cutting, copying, pasting, and selecting items are available on the
Edit menu.

Table 2.2 Edit Menu Commands

Edit Menu Description

Command

Cut Cut the selected text and place in the clipboard. This control
may not be available.

Copy Copy the selected text and place in the clipboard. This control
may not be available.

Paste Paste the text currently in the clipboard to the location of the
Windows cursor. This control may not be available.

Select All Select all items on the current page. This control may not be
available.
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View Menu

Commands related to viewing the various pages in the NVIDIA Control Panel
application modules are available on the View menu.

Table 2.3 View Menu Commands

View Menu
Command

Description

Standard

Select to view and access the majority of commonly used and
simpler tasks in the NVIDIA Control Panel applications. When
the Standard command appears with a check mark, this means
that the Standard view is currently active on your NVIDIA
Control Panel active.

Advanced

Select to view and access certain complex tasks in the NVIDIA
Control Panel applications. These tasks often require some
advanced experience using graphics hardware and software
(drivers). When the Advanced command appears with a check
mark, this means that the Advanced view is currently active on
your NVIDIA Control Panel.

Custom

Select to choose a custom view. This command appears on the
View menu only if you have used the Define Custom Views
command to customize showing/hiding specific screens.

Define Custom
View

To see only those application pages you want to see and use
based on the application modules (Display, 3D Settings, etc.)
that are installed on your system, select Define Custom Views
from the View menu.

Add Desktop
Context Menu

This is selected by default, and adds the NVIDIA Control Panel
menu item to the desktop context menu.

Add "Run with
graphics
processor”
Option

Select this option to add "Run with graphics processor” to the
program context menu.

When this option is selected, you can choose which graphics
processor to use when starting a program as follows:

1. Right-click the program icon.

2. Click Run with graphics processor and then click the
graphics processor to use.

The selection applies only at the time the program is
launched.

NOTES:
» This menu option appears only with systems using NVIDIA ©
Optimus™ technology.

o The driver will automatically use the appropriate graphics
processor if your program is not compatible with the one you
selected.

NVIDIA Control Panel Quick Start Guide
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Table 2.3 View Menu Commands

View Menu Description

Command

Show (Windows XP only) Select to show the NVIDIA Control Panel

Notification notification tray icon in the Windows taskbar notification area.

Tray Icon Clicking the NVIDIA Control Panel notification icon offers a
quick way to configure key NVIDIA Control Panel settings.

Help Menu

Commands related to accessing help, system information, and copyright and version
information are available on the Help menu.

Table 2.4 Help Menu Commands

Help Menu Command Description

NVIDIA Control Panel Access the NVIDIA Control Panel online help.
Help

System Information View detailed information about your system and the
NVIDIA Control Panel configuration.

About NVIDIA Control View NVIDIA Control Panel version and copyright
Panel information.

Group-Specific Menus
These menus appear only when pages from a specific group are open.

Profiles Menu

Commands related to saving, loading, and deleting profiles are available on the Profiles
menu.

Table 2.5 Profiles Menu Commands

Profiles Menu Command Description

Load... Load a profile of display settings you have previously
saved. Click to open the Load Desktop Profile dialog
box and select a .nvp file.

Save... Save the current configuration to a profile file. Click
to open the Save Desktop Profile and enter a name
and path for the .nvp file.

Delete... Delete a profile. Click to open the Delete Desktop
Profile dialog box and locate a profile to delete.
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Display Menu
This menu item appears only when a Display group page is open.

Table 2.6 Display Menu Commands

Display Menu Command  Description

Identify Displays Select to identify the displays configured with your
system.

3D Settings Menu
This menu item appears only when a 3D Settings group page is open on an SLI system.

Table 2.7 3D Settings Menu Commands

3D Settings Menu Description
Command

Show SLI Visual Indicators | Select to verify that SLI rendering is enabled and

working.
Show PhysX Visual Select to verify the type of PhysX acceleration the
Indicator game is using - CPU or GPU - or if PhysX acceleration
is being used at all.
Automatically Update This menu option appears only with systems using
"Preferred Graphics NVIDIA © Optimus™ technology.
Processor” Settings This is selected by default, and lets the driver

periodically download small files to ensure that the
latest programs take advantage of your NVIDIA GPU.
Your custom settings are not affected by this
download. Automatic download requires an internet
connection.

Note: For the purpose of prioritizing future driver
features and optimizations, the driver may collect
the following types of non-personal information:
CPU, GPU, and operating system. Such information
will only be collected on an anonymous, aggregated
basis and can at no time be linked to your personal
identity, IP address, hosthame, username or any
other personally identifiable information.

Where Optimus is used and the information above is
collected by NVIDIA, if you do not wish the driver to
collect any information, uncheck Automatically
Update "Preferred Graphics Processor” Settings in
the 3D Settings menu of the NVIDIA Control Panel.
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Workstation Menu
This menu item appears only when a Workstation group page is open.

Table 2.8 Workstation Menu Commands

Workstation Menu Description
Command
Refresh View Select to refresh the graphical representation of the

displays and graphics cards installed on your system.
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ACCOMPLISHING NVIDIA CONTROL
PANEL TASKS

This chapter provides instructions on how to use the NVIDIA Control Panel to
accomplish common tasks. It contains the following sections:

» Starting the NVIDIA Control Panel
» Accomplishing NVIDIA Control Panel Tasks

% Note: For Windows Vista/Windows 7 - Several features are cur-
rently under development and are not yet supported in the NVIDIA
Control Panel. Consult the release notes for the latest list of unsup-
ported features.

NVIDIA CONFIDENTIAL
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Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

Starting the NVIDIA Control Panel

1 Launch the NVIDIA Control Panel:
Under Windows XP:

* Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

e From the Windows Start menu, select Control Panel, then in %
the Control Panel window, double-click the NVIDIA Control a
Panel icon. Control panel

Under Windows Vista/Windows 7:

¢ Right-click the Windows desktop, then click NVIDIA Control Panel from the
context menu, or

a Click the Start icon, then from the Start menu click Control Panel.

b From the Classic View of the Windows Vista Control Panel, click the NVIDIA
Control Panel icon, or

From the Control Panel Home view of the Windows Vista Control Panel, click
Additional Options and then click NVIDIA Control Panel from the Additional
Options page.

£1) NVIDIA Control Panel
File Edit View Help

Back ~ Advanced Settings ~
|

Select a Task...

.
= 0 Settings .. Adjust Image Settings with Preview T
o SLEEESENEENE This page allows you to preview changes you make to the image and rendering settings. These will be your defauit seftings for your l
= Display hardware-accelerated 3D appications that wiize Drect3D or OpenGL.

+~Change resolution
- Adjust desktop color settings
Rotate display Performance: Preview:
Set up multiple displays 1 ’
=) Video & Television
i Adjust video color settings

Quality:

=l

What do I look for?
Mg fowards the @ Let the 3D applcation decide

Performance side will 5 . .

increase frame rate, (©) Use the advanced 30 image settings  Take me there

m

l but curved nes will (7) Use my preference emphasizing: Quality
appear jagged.

Quality side will improve
the smoothness you
can see on curved fines.

! Moving towards the

Description:

&) System Information Typical usage scenarios:

The groups that appear in the Select a Task pane depend on the NVIDIA hardware
software is installed on your system. For example, the Mobile group is not available
on desktop systems.

2 From the navigation tree in the Select a Tusk pane, click one of the links to open a
specific task page.
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Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

Each group in the navigation tree lists different tasks that you can accomplish, and
each task page provides instructions on how to accomplish what you want. Move the
cursor over listed options to see a description and typical usage scenario for that
option.

Detailed instructions for each task are also available through the online help.

Accomplishing NVIDIA Control Panel Tasks

The NVIDIA Control Panel provides an intuitive layout for locating graphics driver
controls, including most of the controls that were available with the Classic NVIDIA
Control Panel.

e “NVIDIA Control Panel Feature List” on page 19 lists the current features available in the
NVIDIA Control Panel.

e “Correlating to the NVIDIA Classic Control Panel” on page 24 shows where a Classic Control
Panel feature is found in the new NVIDIA Control Panel.

e “NVIDIA Control Panel Groups” on page 26 provides an overview of the NVIDIA Control
Panel pages by group.

NVIDIA Control Panel Quick Start Guide Release 195/196/197 v50 | 18



Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

NVIDIA Control Panel Feature List

Table 3.1  NVIDIA Control Panel Features

Feature

Values (Default in bold)® =~ Notes

Display/TV Controls
Mode control

Resolution

Non-HD display - the
native resolution or the
highest safe resolution
from the monitor EDID is
the default.

HD display - the highest
progressive resolution is
the default.

Refresh rate

Color depth/quality

Custom timings/resolutions

TV Signal Format Selection

M/NTSC, PAL, M/PAL, N/
PAL, Select by country

Connector Selection

Auto-select, Available values depend

DVI - PC display, on the actual

VGA - PC display, connection.

S-Video - SDTV, For DVI, VGA, or
Component connectors,

Component, the values are static and

Composite - SDTV,
Composite - HDTV,

HDMI - HDTV (audio
enabled (Vista and later)),
HDMI-HDTYV (audio disabled
(Vista and later)),
DisplayPort - HDTV,
DisplayPort - PC display,

cannot be changed.

LVDS - laptop display

Color Control

Brightness 0 - 100%, (50%)
Contrast 0 - 100%, (50%)
Gamma 0.50 - 1.50, (1.00)

Digital Vibrance

0 - 100%, (0%)

Image sharpening

Not available with
GeForce 8 series and
later GPUs.

0 - 100%, (0%)

NVIDIA Control Panel Quick Start Guide
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Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

Table 3.1  NVIDIA Control Panel Features
Feature Values (Default in bold)® = Notes
Hue 0 - 359 degrees (30) For GeForce 8 series and

later GPUs

Flicker Filter

0 - 100%, (50%)

For analog TVs

Gray border option Disabled For analog TVs; presents
unused black TV borders
as gray

Digital color format selection RGB, YCbCr For HDMI and

DisplayPort connections

Rotation

0, 90, 180, 270 degrees

Desktop Size and Position

Move CRT screen position

For VGA displays

Flat panel scaling

NVIDIA scaling

NVIDIA scaling with fixed-

aspect ratio
Display’s built-in scaling
No scaling

For non-HD display
modes on DVI/HDMI/
DisplayPort connection

Adjust screen size and position

For analog TVs

Resize HDTV desktop

For HD display modes
(over DVI/HDMI/
DisplayPort/Component
connections) that
support underscan or
desktop resizing.

Pan HD desktop when not resized

Windows XP only;

For HD display modes
(over DVI/HDMI/
DisplayPort/Component
connections) that
support underscan or
desktop resizing.

Multi-display Options
Single-display mode

Dualview (extended mode)

nView Clone Mode

nView Spanning Mode

Windows XP only

Video Controls

“Use video player settings” is the default. If “Use
NVIDIA settings” is selected, the following values

apply.

Color Settings

NVIDIA Control Panel Quick Start Guide
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Table 3.1 NVIDIA Control Panel Features
Feature Values (Default in bold)® =~ Notes
Brightness 0 - 100%, (50%)
Contrast 0 - 100%, (50%)
Hue 0 - 100%, (0%)
Saturation 0 - 100%, (50%)

Gamma (including separate RGB)

0.3 - 3.00, (1.00)

Advanced Color Settings

Dynamic Range

Full (0—255)
Limited (16—235)

Dynamic Contrast Enhancement Disabled GeForce 9 series and
later GPUS

Color Enhancement Disabled GeForce 9 series and
later GPUs

Image Settings

Edge Enhancement

0 - 100%, (0%)

Noise Reduction

0 - 100%, (0%)

Inverse Telecine option Disabled

Internet Video Enhancement option Disabled Select GeForce 8 series
and later GPUs

Digital Audio

Portal to the Windows Sound Settings For GPUs that support

panel digital audio when an
HDMI or DisplayPort
connection is made.

HDCP

Capability verification page For GPUs that support
HDCP.

3D Application Controls

Ambient Occlusion Off, On Windows Vista and later;

GeForce 8 series and
later GPUs

Anisotropic filtering

Application-controlled,
Off, card-specific settings

Antialiasing - Mode

Application-controlled,
Off, Enhance the
application setting,
Override any application
setting

Antialiasing - Setting

Application-controlled,
card-specific settings

NVIDIA Control Panel Quick Start Guide
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Table 3.1  NVIDIA Control Panel Features
Feature Values (Default in bold)® = Notes
Antialiasing line gamma Off, On
Antialiasing full screen gamma Off, On
Antialiasing - gamma correction Off, On

Antialiasing - transparency

Off, Multisampling,
supersampling

Buffer-flipping mode

Auto-select,
Block transfer

NVIDIA Quadro cards

Conformant texture clamp

Use hardware, Off, Use
OpenGL specification

Enable Overlay

Off, On

NVIDIA Quadro cards
Windows XP only

Error reporting

Off, On

Enables/disables
OpenGL error checking

Exported pixel types

8-bpp and/or RGB555
format, None

NVIDIA Quadro cards

OpenGL Extension limit

Off, On

For older OpenGL
applications that cannot
process long extension
strings.

Force Mipmaps

None, Bilinear, Trilinear

HDR lighting

Allow, Force off

To turn off high dynamic
range lighting

Maximize texture memory

Off, On

NVIDIA Quadro cards

Maximum pre-rendered frames

0,1,2,3,4,5,6,7,8

Limits frame pre-
rendering

Multi-display/mixed-GPU
acceleration

Single, Compatible, or
Multiple display
performance modes

Multi-GPU performance mode

single-GPU, alternate
frame rendering 1 & 2,
split frame rendering, or
multi-GPU antialiasing

Power management mode

Adaptive, Prefer
maximum performance

GeForce 9 series and
later GPUs; Windows
Vista and later

Preferred Refresh Rate

Application-controlled,
Highest available

Windows Vista and later

NVIDIA Control Panel Quick Start Guide
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NVIDIA Control Panel Features

Feature

Values (Default in bold)?

Notes

SLI performance modes

single-GPU, alternate
frame rendering 1 & 2,
split frame rendering, or
SLI antialiasing

Stereo - Display mode Select to match stereo NVIDIA Quadro cards
viewing hardware

Stereo - Enable Off, On NVIDIA Quadro cards

Stereo - Force shuttering Off, On NVIDIA Quadro cards

Stereo - SLI rendering mode NVIDIA Quadro cards

Stereo - Swap eyes Off, On NVIDIA Quadro cards

Texture color depth

Desktop color depth

NVIDIA Quadro cards

Texture filtering - anisotropic mip
filter optimization

Off, On

Texture filtering - anisotropic sample | Off, On
filter optimization
Texture filtering - Negative LOD bias = Allow, Clamp

Texture filtering - Quality

High quality, Quality,
Performance, High

Balance between quality
and performance

performance
Texture filtering - Trilinear Off, On
optimization
Threaded optimization Off, On For systems with
multiple CPUs
Triple buffering Off, On
Unified back/depth buffer Off, On NVIDIA Quadro cards

Windows XP only

Vertical sync

Use the 3D application
setting, Force off, Force
on

PhysX Configuration

For systems with PhysX-
capable GPUs, a
minimum of 256MB
dedicated graphics
memory, and a minimum
of 32 processor cores

SLI/Multi-GPU Configuration

For systems with SLI or
multi-GPU ready GPUs.

3-way SLI Mode

NVIDIA Control Panel Quick Start Guide

Release 195/196/197 v50 | 23




Table 3.1

Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

NVIDIA Control Panel Features

Feature

Values (Default in bold)?

Notes

Quad SLI Mode

a. Defaults for the 3D application controls are for the Global Settings tab. Under the Program Set-
tings tab, Use global setting is typically the default setting.

Correlating to the NVIDIA Classic Control Panel

Table 3.2 lists the features as presented in the Classic Control Panel and identifies the
page in the NVIDIA Control Panel where you can find the corresponding controls.

Table 3.2  Graphics Driver Tasks in the NVIDIA Control Panel

Feature NVIDIA Control Panel | Notes
Group - Page
Advanced Timings ' Display - Change
Resolution
Antialiasing 3D Settings - Manage
3D Settings
Application Profiles 3D Settings - Manage
3D Settings
Color Depth Display - Change
Resolution

Custom Timings

Desktop Color Settings

Driver Settings

‘ Display - Change

Resolution

‘ Display - Adjust

Desktop Color Settings

3D Settings - Manage

3D Settings

Desktop Overlap

Frame Synchronization

Workstation - Adjust
Edge Overlap

Workstation -
Synchronize Displays

Available only with NVIDIA Quadro
FX cards.

Available with NVIDIA Quadro G-
Sync cards.

HDTV Setup

Multi-display configuration ‘

nView Clone Mode

nView Span Modes

NVIDIA Control Panel Quick Start Guide

Display - Change
Resolution
Display - Set Up
Multiple Dislays

‘ Display - Set Up

Multiple Displays

‘ Display - Set Up

Multiple Displays

Available only with Windows XP.
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Feature

NVRotate

Chapter 03 : Accomplishing NVIDIA Control Panel Tasks

Group - Page

Display - Rotate
Display

Graphics Driver Tasks in the NVIDIA Control Panel

NVIDIA Control Panel

Notes

Performance and Quality
Settings

PowerMizer

Refresh Rate Settings

Resolution Settings

Screen Position on CRT

Screen Position on TV

SDI (Graphics to SDI Output)

SLI Configuration

Temperature Settings

TV Setup

Video Color Settings

3D Settings - Adjust
Image Settings with
Preview

Mobile - Change
PowerMizer Settings

Display - Change
Resolution
Display - Change
Resolution
Display - Adjust
Desktop Size and
Position

Display - Adjust
Desktop Size and
Position

Workstation - Send
Graphics to SDI
Output

3D Settings - Set SLI
Configuration

Performance

Display - Change
Resolution

Video - Adjust Video
Color Settings

Available only with notebook
computers.

Available only with Windows XP.

Available only with NVIDIA Quadro
FX SDI cards.

Requires NVIDIA System Tools
software

Overclocking

NVIDIA Control Panel Quick Start Guide

Performance

Requires NVIDIA System Tools
software
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NVIDIA Control Panel Groups

This section provides an overview of the NVIDIA Control Panel groups.
“Using the Display Pages” on page 26

“Using the Video Pages” on page 27

“Using the 3D Settings Pages” on page 27

“Using the Stereoscopic 3D Pages” on page 27

“Using the Mobile Pages” on page 27

“Using the Workstation Pages” on page 28

“Using the Networking Pages” on page 28

“Using the Storage Pages” on page 29

“Using the Performance Pages” on page 29

Vv v v iviVvivYVvYvVvy

“Using the System Update Pages” on page 29

Note: For Windows Versions - Support for some features under

N Windows Vista or Windows 7 is in development and may not be
available with your GeForce graphics driver version. Consult the
release notes for the latest list of unsupported features.

Using the Display Pages

The actual tasks available on your system depend on your system hardware, such as the

number and type of displays connected. Use the Display group pages to:

» Run the wizard to optimize your display configuration.

» Change the display resolution.

» Change the scaling on your flat panel display.

» Adjust desktop color settings.

» Rotate the display.

» Adjust custom timings.

» Configure multiple displays, including Spanning or Clone modes.
Spanning modes are available only with Windows XP.

» Adjust your television picture quality and video color settings for the best possible
viewing in its environment.

» Change the position and size of the desktop/video to best fit your television or HDTV
(high definition television) screen.

» Change the signal format to use for your standard television or HDTV as well as
change country-specific signal or the HDTV format.
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» Verify the HDCP capability of your system.

» Access digital audio controls.

Using the Video Pages

The actual tasks available on your system depend on your system hardware, such as
whether or not you have a TV connected and enabled. Use the Video page to:

» Adjust video and image color settings.

Using the 3D Settings Pages

The actual tasks available on your system depend on your system hardware, such as
whether or not you have an SLI-ready system. Use the 3D Settings page to:

» Change the image and rendering settings of your 3D applications and games that
utilize Direct3D and OpenGL technology.

» Assign specific 3D settings to a game so that these settings automatically load when a
game is launched (available under Advanced view).

» Set up your SLI or multi-GPU configuration as well as PhysX configuration.

GPU temperature monitoring and GPU overclocking features are not included in the 3D
Settings page. To use this functionality you must install NVIDIA nTune software.

Using the Stereoscopic 3D Pages

The Stereoscopic 3D pages are part of the NVIDIA 3D Vision software for viewing 3D
programs and games in stereoscopic 3D. Use the Stereoscopic 3D pages to:

» Control stereoscopic 3D settings.

Enable stereoscopic 3D, adjust 3D depth, select a 3D laser sight, view and set the
keyboard shortcuts, and run the setup wizard and various tests.

» View game compatibility.

See a stereoscopic 3D compatibility rating for a number of games, along with possible
issues and recommendations for each game.

Using the Mobile Pages

The Mobile group is available if the NVIDIA software is installed on a notebook
computer under Windows XP.

Use the Mobile page to extend your notebook computer’s battery life using NVIDIA
PowerMizer technology
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Using the Workstation Pages

The Workstation group is available if you have an NVIDIA Quadro FX graphics card
installed.

The actual tasks available depend on which NVIDIA Quadro FX product you have
installed. Use the Workstation page to:
» Synchronize your displays using frame sync or genlock technology.

» View a graphical representation of the displays and graphics cards installed on your
system.

» Manage serial digital interface (SDI) output (requires NVIDIA Quadro FX SDI
solution.)

» Configure SLI Mosaic mode (requires Quadro Plex unit) to combine multiple displays
into a larger virtual canvass.

» Overlap the edges of adjacent displays.
Display edge blending is no longer available.

Using the Networking Pages

The Networking group pages are part of the nForce drivers Networking software for
NVIDIA nForce-based PCs.

Use the Networking pages to optimize your network performance and increase your
network bandwidth with the following technologies:

» NVIDIA FirstPacket offers a new way to manage the traffic on your personal
computer, allowing you to more effectively manage and improve the performance of
networked games and other applications that are sensitive to network delay (latency),
such as Voice-over-IP (VoIP).

» NVIDIA TCP/IP Acceleration technology is a networking solution that moves the
processing of TCP/IP network traffic from your computer’s CPU to its nForce
hardware resulting in greatly improved system performance.

» NVIDIA Teaming technology combines all the NVIDIA Ethernet interfaces on your
system to form a team, resulting in increased bandwidth and network redundancy.

» Alert Standard Format (ASF) controls lets you set up alerts and remote system
management in an OS-present or OS-absent environment.
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Using the Storage Pages

The Storage group pages are part of the nForce drivers MediaShield Storage software for
NVIDIA nForce-based PCs.

Use the Storage pages to

» Create and manage RAID 0, RAID 1, RAID 0+1, RAID 5, and spanning arrays.

» Run SMART tests on your RAID array disk drives.

Using the Performance Pages

The Performance group pages are part of the nForce drivers System Tools software for
NVIDIA nForce-based PCs.
Use the Performance pages to:

» Manage system tuning and profiles for nForce MCP clocks, voltages, timings, and
fans.

» Manage Enthusiast System Architecture (ESA) components.
» View detailed system information for your nForce-based PC.

» Overclock your GeForce GPU.

Using the System Update Pages

The System Update pages are part of the nForce drivers System Tools software for
NVIDIA nForce-based PCs.

Use the system update pages to:

» Automatically check for nForce and GeForce driver updates.

» Update your system BIOS.

» Update firmware for the Enthusiast System Architecture (ESA) components.
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Notice

ALL NVIDIA DESIGN SPECIFICATIONS, REFERENCE BOARDS, FILES, DRAWINGS, DIAGNOSTICS, LISTS, AND
OTHER DOCUMENTS (TOGETHER AND SEPARATELY, "MATERIALS") ARE BEING PROVIDED "AS IS." NVIDIA MAKES
NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE WITH RESPECT TO THE MATERIALS, AND
EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS
FOR A PARTICULAR PURPOSE.

Information furnished is believed to be accurate and reliable. However, NVIDIA Corporation assumes no
responsibility for the consequences of use of such information or for any infringement of patents or other
rights of third parties that may result from its use. No license is granted by implication of otherwise under
any patent rights of NVIDIA Corporation. Specifications mentioned in this publication are subject to change
without notice. This publication supersedes and replaces all other information previously supplied. NVIDIA
Corporation products are not authorized as critical components in life support devices or systems without
express written approval of NVIDIA Corporation.

HDMI

HDMI, the HDMI logo, and High-Definition Multimedia Interface are trademarks or registered trademarks of
HDMI Licensing LLC.

Macrovision Compliance Statement

NVIDIA Products that are Macrovision enabled can only be sold or distributed to buyers with a valid and
existing authorization from Macrovision to purchase and incorporate the device into buyer's products.

Macrovision copy protection technology is protected by U.S. patent numbers 5,583,936; 6,516,132;
6,836,549; and 7,050,698 and other intellectual property rights. The use of Macrovision's copy protection
technology in the device must be authorized by Macrovision and is intended for home and other limited
pay-per-view uses only, unless otherwise authorized in writing by Macrovision. Reverse engineering or
disassembly is prohibited.

OpenCL
OpenCL is a trademark of Apple Inc. used under license to the Khronos Group Inc.
Trademarks

NVIDIA and the NVIDIA logo are trademarks or registered trademarks of NVIDIA Corporation in the United
States and other countries. Other company and product names may be trademarks of the respective
companies with which they are associated.

Copyright
© 2009, 2010 NVIDIA Corporation. All rights reserved.
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www.nvidia.com NVIDIA.
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